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In this case study:

*  Case study G—Introduction

+  Tutorial G1—Building a model from drillholes (erosional series f5)
*  Tutorial G2—Building a model from drillholes (erosional series f2)
*  Tutorial G3—Building a model from drillholes (onlapping series 3)
*  Tutorial G4—Building a model from drillholes (onlapping series f4)
*  Tutorial G5—Building a model from drillholes (onlapping series 6)
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Case study G—Introduction

Parent topic:
Tutorial case
study G
(Drillholes)

Project data preparation

Parent topic:
Case study G—
Introduction

In this section:

Project data preparation

Topography of Case Study G

Geology of Case Study G
Strategy for Case Study G
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For this tutorial we have created a project area containing synthetic geology.

We have prepared a beginning project file for this case study. You open it at the start

of Tutorial G1—Building a model from drillholes (erosional series f5).

We have:

Defined the project dimensions.

Minimum Maximum Range
East 483,100 491,700 8,600 m
North 4,280,700 4,291,500 10,800 m
RL —2000 4000 6000 m

Created a 3D GeoModeller project using these extents.

Loaded a digital terrain model (DTM) grid to create the topography for the project.
See Topography of Case Study G for details.

Created an initial stratigraphic pile. The top or bottom reference for the pile is
Bottom of formations. See Geology of Case Study G for details.

Created a series of sections: s81N, s83N, s85N, s87N, s8IN, s91N.
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Topography of Case Study G
Parent topic: The following illustration shows the topography of the Case Study G region.
Case study G—
Introduction e
File | Grid Metadata | Statistics |

Datym R

Prajection RAL

Rotation oo'o"

Precision IEEE4Byh=Real

Murmber of bands 1

Mumber of lines 55

Mumber of cells per line 44

Cell size X 200.0

Cell size ¥ 200.0

Qrigin X 483100.0

Origin ¥ 4291500.0

Hull cell value -29999.0

Histograrn | Band statistics| Histogram | Band statistis:

Statistics Values

Minifmum 2586.554199
Maximum 3205.873779
Mean 2981.651058
Std Dev 122679677
Sarnples 2420

MNulls 0

Wariance 15030,303152

Geology of Case Study G

Parent topic: The following illustration shows the geology
Case study G—

Introduction

of the case study region.

Reference (Tap/Battom): Bottom

—_ a1l Series_f6 { ONLAP )

Series_fa (EROD 5

Series_f4 { OMLAFP ) 4

Series_f3 { OMLAFP )

Series_f2 (EROD

1)

Series_f1 (EROD fl

Notes about the project:

There are six formations, f1 f2 f3 f4 f5 and {6 in a roughly layered sequence. Two
of the units are erosional (Relationship = Erode) across the older strata, and the
other units have an onlapping relationship (Relationship = Onlap) to older strata.

The formations are in a correct stratigraphic order
+ f1 (oldest) at the bottom of the pile
+ f6 (youngest) at the top

This project uses Bottoms of formations
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Strategy for Case Study G

Parent topic: We have found that a useful strategy for building any model in 3D GeoModeller is
Case study G— to:
Introduction

1 Work stratigraphically downwards through the erosional or cross-cutting events
(in this case study, first f5 and then £2).

2 Work stratigraphically upwards through any onlapping series occurring between
these (in this case study, {3, f4, f6).

We recommend this work order because, if you model the youngest, cross-cutting
event or geological surface and get get it right, all subsequent modelling work on all
other (older) events or surfaces has no impact on that earlier modelling of the younger
event.

Note that this tutorial follows one pathway towards building a 3D model of the Case
Study G project geology. There are several equally valid alternative approaches.

Tutorial G1—Building a model from drillholes (erosional series 5)

Parent topic: According to our strategy (see Strategy for Case Study G), we model the youngest
Tutorial case erosional series first.

study G

(Drillholes) In this tutorial we:

1 Import drillhole data
2 Create, display and refine the model for one formation
Stages in the tutorial:
G1 Stage 1—Open the prepared 3D GeoModeller Project for Case Study G
G1 Stage 2—Import the drillhole data
G1 Stage 3—Arrange the 2D Viewer windows
G1 Stage 4—Project the Drillholes in each 2D Section-View
G1 Stage 5—Prepare the project for modelling
G1 Stage 6—Comparing the model with drillhole observations
G1 Stage 7—Creating a 3D view
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G1 Stage 1—Open the prepared 3D GeoModeller Project for Case Study G

Parent topic:
Tutorial G1—
Building a
model from
drillholes
(erosional
series f5)

G1 Stage 1—Steps
1 Ifrequired, save and close any project that you are currently working on.
2 From the main menu choose Project > Open OR

From the Project toolbar choose Open & OR
Press CTRL+O.

Open:
GeoModel ler\tutorial\CaseStudyG\TutorialG1\Beginning_project
\TutorialGl_Start.xml

3 Save the project with a new name in the folder you are using for your tutorial
data.

From the main menu choose Project > Save As OR

From the Project toolbar choose Save As & OR
Press CTRL+SHIFT+S.

Note that a completed version of Stage 2 of the tutorial is available in
GeoModel ler\tutorial\CaseStudyG\TutorialGl\Completed_project\
TutorialGl_1 Load Holes\TutorialGl_ 1 Load Holes.xml. Do not
overwrite it.
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G1 Stage 1—Discussion and exploration

To view the formations, from the main menu choose Geology > Formations:
Create or Edit.

To view the whole stratigraphic pile, from the main menu choose Geology >
Stratigraphic Pile: Visualise.
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G1 Stage 2—Import the drillhole data

Parent topic: Our contractor has drilled a set of 40 deep vertical holes on the six sections. These

Euﬁ’;ial G1— holes are 4500 m deep (nice drilling budget!) and there are about six holes per section.
urcing a The sections are 2000 m apart and the holes are at various spacings, 600 m — 1800 m.

model from

?ri“bolesl The drillhole data are in a commonly used drillhole data file format. This is a set of
erosiona

series £5) three files containing the drillhole collars, surveys, and geology.

For interest, you could examine these files in a text editor. For example, you could

examine:
GeoModel ler\tutorial\CaseStudyG\TutorialGl1\Data\Drilling

\VDH40Holes_Geology.csv

The first line of each file gives field names for each column of data. You need to set
these field names in 3D GeoModeller when you import the drillhole data. The
following table contains the field name list for each file.

File Field names

VDH40Holes_Collars.csv HolelD,X,Y,Z,EOH_Depth
VDH_s81N 01,483500,4281000,2755,4500
VDH_s81N_04,485300,4281000,2761,4500

VDH40Holes_Survey.csv HolelD,Dip,Azimuth,Depth
VDH_s81N 01,90,0,0
VDH_s81N_01,90,0,4500

VDH40Holes_Geology.csv HolelD,From,To,Lithology
VDH_s81N_01,0,743,f6
VDH_s81N_01,743,2380,f5

G1 Stage 2—Steps

1 Ensure that you are using your own saved version of the project according to G1
Stage 1—Open the prepared 3D GeoModeller Project for Case Study G.

Do not overwrite the completed version of this tutorial that we have supplied in
your 3D GeoModeller installation.

2 From the main menu choose Import > Import drillhole data > Import collars,
surveys, geology (3 files).

Project Edit Section Geology Model Geophysics Interpolation Export View Window Research Help

E E Q Ej B|U F’|£ )/ /s ¢ f &= GIS and Other Binary Located Data G E||e

* Explore =d| | L VI | 2Dt e
= &3 DrilonlapErode_03a_Bo o s Map_Topo 2D Sections =

|y #P

+ [l Formations 3D Data » I
B Dykes Drillhole ' 33%% 3 Files (Col
SL\T ’ HFauIm Grid and Mesh | &'}. Y
+ 0 + ﬁ Sections Seismic | u@ —

This starts the CSV Data Import - 3-table (Collar,Survey,Geology) Drillholes
wizard as shown below
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f %2 CSV Data Import - 3-table (_C(;a_r, S:m;y, G;E;;y) Drillhcles @
Steps Select data type to import (Step 1 of 9)
1. Select data type to import Collar Table
2. Parse CSV collar file
= ?;Ec(;fr\;mlums s 5T .0.ee8662c60eac_x86\utorial\CaseStudyG\TutorialG 1\Data \Driling \WDH40Holes_Collars. csv Browse...
4, Parse CSV survey file
5. Map CSV colums to survey Survey Table
data structure
g ;aar;ecgsﬁsz_::g; zl:ology 1.eeB662c60eac_x86 \tutorial\CaseStudyGiTutorialG 1\DataDrilling \WDH40Holes_Surveys.csv Browse...
data structure
8. Map geologic objects in Geology Table
project data
9.  Verify imports 1.eeB662c60eac_x86 \utorial\CaseStudyG TutorialG 1\Data\Driling \VDH40Holes_Geology.csv
Back MNext = Finis} Cancel
3 In the first page of the CSV Data Import - 3-table wizard dialog box, choose
Browse for the Collar Table and locate the drillhole collars file
GeoModel ler\tutorial\CaseStudyG\TutorialGl\Data\Drilling
\VDH40Holes_Collars.csv
4 Repeat step 2 for Survey Table and Geology Table, correspondingly named.
Contents Help | Top © 2013 BRGM & Desmond Fitzgerald & Associates Pty Ltd 4| Back | p
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5 Select the correct data file field name from the drop-down lists for each 3D

examination above or the names shown in the data preview panels shown below:

Steps Parse CSV collar file (Step 2 of 9)
;'_ Sdm‘,‘g‘;,m. Inxort CSV separator Text qualifiers Decimal separator
2 :?Eﬁ‘;mm s [] [ \t] Tabulation [][;] Semicolon [¥] [, ] Comma [¥] [ "] Double Quote [# [.]1Dot
4. Parse CSV survey file e et =
5, Map CSV colums to survey ][ 1Space [F1[. 100t [ Other [T '] Single Quote [1[,]Comma
data structure
6. Parse C5V geology fie
7. Map CSV colums to geology File reading parameters
data structure
8, Map geologic objectsin Data start at row: 1 | [ Preview entire file 50 &
project data
9. \Verify imports [] Fixed columns  [] Treat consecutive delimiters as one [¥] Skip leading spaces
HoleID X ¥ z EOH_Depth
1 WVDH s81N 01 483500 4231000 2755 4500 P
2 VDH s81IN 04 435300 4281000 2761 4500 B
3 VDH s81IN 07 437100 4281000 2936 4500
i VDH s81M 09 465300 4251000 2887 4500
5 WVDH s81N 10 483900 4231000 2953 4500 E
] VDH s81N 11 439500 4281000 2960 4500
7 VDH s81IN 14 491300 4281000 2903 4500
8 WDH s83M 02 454100 4233000 2958 4500 |
9 VDH s83N 04 485300 4233000 2834 4500
10 WVDH s83N 07 437100 4283000 2967 4500
11 VDH s83M 09 438300 4283000 2928 4500
12 WVDH s83M 12 450100 42533000 3098 4500
13 WDH s83M 13 490700 4733000 3024 4500 i
Column size: [] Auto | E = l == “ [ Reset I

Choose Next.

Steps Map CSV col to collar data structure (Step 3 of 9)
;- 'SE'K*P csdavh m“"’ﬂ?‘l’;"‘wrt HoleID X Y z EOH_Depth
. arse
P 1 VDH s31M 01 |483500 4251000 2755 4500 -
ot e 2 VDH s31N 04 [485300 4251000 2761 4500
4. Parse CSV survey file 3 VDH s81N 07 |487100 4251000 2936 4500
5, Map C5V colums to survey 4 VDH s31N 03 [488300 4251000 2887 4500 E
data structure 5 VDH s81N 10 [483900 4251000 2953 4500
6. Parse CSV geology file 3 VDH sBIN 11  |489500 4281000 2960 4500 A
= Z‘:;‘;i‘:gf:smge"k’g\’ 7 VDH s8IN 14 |431300 4281000 2903 4500
B. Mo eckiscobr B VDH 583N 02 [484100 4253000 2953 4500
Bt dat 9 VDH s83M 04 [485300 4253000 2834 4500
N o 10 VDH 583N 07 |487100 4253000 2967 4500
11 VDH s83M 03 |488300 4253000 2923 4500 -
Column size: [7] Auto [ E= ” == ” [ Reset
Data Source Style Source Null value Unit Conversion
Hole 1D File [HoleID =
% File X - -
¥ File v ) )
z File [Z = -]
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Steps Parse CSV survey file (Step 4 of 9)
;‘ ??:g?;::ﬁ;mt CSV separator Text qualifiers Decimal separator
E: :;Sﬁ;mwc‘am 1 [ [;1 Semicalon [ .1 Comma [ "] Double Quote [.]Dat
;— ::ﬁsﬁ:l::::::uty [F1[ 1Space [F1[-]1Det [ other [711'] Single Quote 11,1 Comma
data structure
6. Parse CSV geology file
7. Map CSV colums to geology File reading parameters
data structure :
8. Map geologic ohjects in Data start at row: 1l% [ Preview entire file 50 =%
project data
9.  Verify imports || Fixed columns [] Treat consecutive delimiters as one [¥] Skip leading spaces
HoleID Dip Azimuth Depth
1 VDH s81N 01 90 ] 0 -
2 VDH s81N 01 90 ] 4500 T
3 VDH s81N 04 90 ] ]
4 VDH s81N 04 90 ] 4500
5 VDH s81N 07 50 0 0 2
] VDH s81N 07 90 ] 4500
7 VDH s81N 09 90 ] ]
8 VDH s81N 09 90 ] 4500 [
9 VDH s81N 10 90 ] ]
10 VDH s81N 10 90 ] 4500
11 VDH s81N 11 90 ] ]
12 VDH s81N 11 90 ] 4500
n n el

13 WVDH s31M 14 an
Column size: [7] Auto | E =1 [ == H Reset

Choose Next.

Steps Map CSV col to survey data structure (Step 5 of 9)
1. Select data type to import HoleID Dip Azimuth Depth
2 P 1 VDH s81N 01 a0 o o
3. Map CSV colums to collar data. g hi
e : 5 VDH s8IN 01 50 o 4500
4.  Parse CSV survey file 3 VDH s81N 04 90 0 0 L
5. Map C5SV colums to G VDH s81N 04 ] ] 4500 T
survey data structure 5 VDH s81N 07 a0 [ 0 4
6. Parse CSV gealogy file [ VDH s81N 07 90 0 4500
7 :‘:;ES‘IZST“’MY 7 VDH saiN 09 20 0 0
8 Map gedlonc e 8 VDH s81N 09 ] ] 4500
bt daia 3 VDH s8IN 10 50 o o
9. Verify imports 10 VDH s81N 10 90 ] 4500 -
Column size: [~] Auto [ E= ” == ” [—Reset
Data Source Style Source Mull value Unit Conversion
Hole 1D File |HoleD =)
Dip File Dip =
Bearing File | Azimuth =)
Survey Depth File :[_Jeqﬁw - ::m -

[T Treat negative dip as down

Choose Next.
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Ne ma

o

Select data type to import
Parse CSV collar file

Map CSV colums to collar data

structure

Parse CSV survey file

Map CSV colums to survey
data structure

Parse C5V geology file

Map CSV colums to geclogy

data structure

Map geologic objects in
project data

Verify imports

CSV separator Text qualifiers

Decimal separator

i [T [;1 Semicalon [.] Comma [#] [ "] Double Quote [#[.]1Det

[1[ 1Space [1[.]1Det [] other [ ['] Single Quote [1[,] Comma
File reading parameters

Data startatrow: | 144 [ Preview entire file 504

[ Fixed columns  [| Treat consecutive delimiters as one Skip leading spaces

HoleID From To Lithology
1: VDH s81N 01 1] 743 fa i
2 VDH s81N 01 743 2330 5 B
3 VDH s81N 01 2330 3968 f2
4 VDH s81N 01 3968 4500 f1
5 VDH s81N 04 1] 666 fa =
] VDH s81N 04 666 2915 5
7. VDH s81N 04 2915 3294 f2
8 VDH s81N 04 3294 4500 f1 o
9 VDH s81N 07 ] 594 fa
10 VDH s81N 07 594 3923 5
11 VDH s81N 07 3923 4500 f1
12 VDH s81N 09 1] 345 fa
395 f5 =

13 \VDH_sA1N 09 345
Column size: [7] Auto | B =1 I == ][ [ Reset ]

Finish

Note, of course, that the lithology coding in the geology file must correspond to
geology formations defined in the 3D GeoModeller project.

Choose Next.

Steps Map CSV col to geology data structure (Step 7 of 9)
;_' Pm grmw_;h‘mt HolelD From To Lithology
. Parse
3, MapCSV col 5 ol 1 VDH s81N 01 0 743 fa i
s 2 VDH s8IN 01 743 2330 s
4. Parse CSV survey file 3 VDH s81N 01 2330 3968 f2
5. Map CSV colums to survey 4 VDH s&81M 01 3968 4500 f1 =
data structure 5 VDH s81N 04 0 666 1i]
6. Parse CSV geclogy file 3 VDH s31N 04 566 7915 f5 i
7. ""’EG"::;"""“ 7 VDH s81N 04 2915 3294 2
SLr
8/ Mop occlod orc i 8 VDH s31N 04 3294 4500 1
it data 3 VDH s8IN 07 o 594 6
9, Verify imports 10 VDH s81N 07 594 3923 f5
11: VDH s81N 07 3923 4500 f1 -
Column size: [7] Auto [ E= ” == ” Reset
Data Source Style Source Mull value Unit Conversion
Haole ID File [HoleID )
Depth From File :Fr_um = :m -
Depth To File :To | | | |m -
Geology Code File \.Liﬁ'ln|0(_:|¥' =

=
Contents Help | Top © 2013 BRGM & Desmond Fitzgerald & Associates Pty Ltd 4| Back | p



GeoModeller User Manual

Tutorial case study G (Drillholes) 11

Contents | Help | Top

4 | Back | p

Map

bjects in project data (Step B of 9)

Select data type to import

Parse CSV collar file

Map CSV colums to collar data

structure

Parse CSV survey file

Map CSV colums to survey

data structure

Parse CSV geology file

Map CSV colums to geclogy

data structure

8. Map geologic objects in
project data

9,  Verify imports

W

Wk

b 11

Geological objects mapping

Geologic object Action Merge to
Import all
f& | Import -~ |®mfa -

5 | Import -
f4 | Import -
f3 | Import -
f2 | Import -

f1 | Import -

4|

[T | }

[ Shaw imported after finish

Finish

Choose Next.

3. Map CSV colums to collar data

structure

Parse CSV survey file

Map CSV colums to survey

data structure

6. Parse CSV geology file

7. Map CSV colums to geclogy
data structure

8. Map geologic objects in
project data

9. Verify imports

Verify imports (Step 9 of 9)
Summary
Imported 40
Total 40
No Flag Hole ID Comments
1 o  |VDH_sBIN_01 =
2 o  |VDH_sBIN_04 I
3 o  |VDH_sBIN_07 1=
4 o  |[VDH_sBIN_09 =
5 o  |VDH_sBIN_10
3 of  |[VDH_sBIN_11
7 o  |VDH_sBIN_14
3 of  |VDH_s83N_02
E] of  |VDH_s83N_04
10 o  |VDH_s83N_07
11 of  |VDH s83N 09 T
Q? Validation Passed, imported &> Validation Warning, imported 3 validation Failure, not imported

Choose Finish.

View the 40 drillholes in the 3D Viewer. (If not already displayed) In the Project
Explorer, from the Drillholes shortcut menu, choose Show.
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6 Save your project
From the main menu choose Project > Save OR

From the Project toolbar choose Save & OR
Press CTRL#S.

Note that a completed version of Stage 2 of the tutorial is available in
\GeoModel ler\tutorial\CaseStudyG\TutorialG1l\Completed_project\
TutorialGl_1 lLoad Holes\TutorialGl_1 Load Holes.xml. Do not
overwrite it.

G1 Stage 3—Arrange the 2D Viewer windows

Parent topic: 3D GeoModeller has a powerful window arrangement feature. For this project, it is
Tutorial G1— useful to view all six drill-sections in a tiled window arrangement.

Building a

model from G1 Stage 3—Steps

drillholes . . . .

(erosional 1 Expand the 2D Viewer so that it occupies about 75% of the main 3D GeoModeller
series f5) window

Drag the border between the 2D Viewer and the 3D Viewer to the right.

2 Drag the s91N tab so that it becomes a window above the rest of the 2D Viewer
tabs.

In the 2D Viewer, drag the s91N tab down in the 2D Viewer window. 3D
GeoModeller displays a grey rectangular drop spot. This shows the size and
position of the new window. Drop the s91N tab. s91N is now in its own window.

Drag s91N tab down and drop Horizontal split

Contents Help | Top © 2013 BRGM & Desmond Fitzgerald & Associates Pty Ltd 4| Back | p
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3 Drag the s89N tab to become a tab in the s91N window

In the 2D Viewer, drag the s89N tab to the middle of the of the s91N window. 3D
GeoModeller displays a grey rectangular drop spot that covers the whole s91N
window. If a half-sized drop spot appears, drag the tab further up or down until
you see a full-sized drop spot. Drop the s89N tab. s89N is now a tab of the upper
window.

Drag s89N tab to top window and drop Two tabs in top window

_Drop spot is

anywhere in top S91IN & s89N

window

4  Drag the s91N tab into its own window at the right, separating it from the sS89N
window.

In the 2D Viewer, drag the s91N tab to the right border of the upper window. 3D
GeoModeller displays a grey rectangular drop spot. This shows the size and
position of the new window. Drop the sS91N tab. s91N now has its own window to
the right of s89N.

Drag s89N tab to right edge and drop Top window split
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5 Continue using this technique and create the window arrangement shown in the
illustraton below.

You may need to adjust the relative widths of the 2D Viewer windows as you go
(see step 1 of this stage for instruction)

4 Geobtodeller  D:\GeaModeller\Projects\DemoTraining\DrilloniapErode\roject\Dril niapErode_01a_BoxTopoPilesections_4lriolesLoaded
Prowet. Secun Mo el h teb

P AN / w<ewr anl @

6 Use Zoom—Fit section to window [E3] in the 2D Toolbar to fit each section view
1into its window.

G1 Stage 4—Project the Drillholes in each 2D Section-View

Parent topic: Drillholes are separate data structures within 3D GeoModeller. They do not ‘belong’
T“t_;’(‘i{ial G1— to any particular section. You can project drillholes onto nearby sections. This shows
Building a the drillhole geology intervals on the target section in the 2D Viewer.

model from

drillholes G1 Stage 4—Steps

(erosional

series f5) 1 In the Model toolbar choose Project data onto section in 2D Viewer g .

3D GeoModeller displays the Project data onto section dialog box.

52 Project data onto sections in 2D Viewer |i|
Sections Geology Data
§ s8I o f5
§ s83n 5
§ s85n B 4
§ s 3
& 589N =R
o
Select Al || Deselect Al || Invert | | Select Al || Deselect Al || Invert |
Parameters
Maximum distance of projection 1.
Data to Project
from 2D Sections
from Hingelines
/| from Drillhole Contacts
/| from 3D Points
/| from Drillhole Trace
| ?Help | | JOK || JApply || mclose |
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From the Sections list select all sections s81N, s83N, s85N, s87N, s89IN, and
s91N.

For Maximum distance of projection, enter 1. All of the drillholes are exactly on
these project sections, so this is an appropriate distance.

Clear from 2D Sections and from Hingelines.
Check From Drillholes Contacts, from3D Points, and fromDrillhole Trace.
Choose Apply.

Contents Help | Top
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2 3D GeoModeller displays the projected drillholes.

Wodel Gesphyic . Tapent Yiew indza Reseurch velp

T
B EY AOEY L S

Blo DS AASEEa

o B N e

3 Choose Close.

G1 Stage 5—Prepare the project for modelling

Parent topic:
Tutorial G1—
Building a
model from
drillholes
(erosional
series f5)

The first task in this tutorial is to model formation f5.

To model any geology surface, 3D GeoModeller requires the following:

+ At least one contact point for each formation within a series AND

+ At least one point of orientation data for one of the formations within the series.

In our case, we have no contact points as such. However, 3D GeoModeller
automatically extracts valid contact points from the geology intervals described in the
drillhole data. It turns out that there are numerous contact points in the assemblage
of 40 drillholes imported here. (Note: 3D GeoModeller may not necessarily find a
geology contact from drill hole data. If it cannot, then you must supply your own
contact points before it can compute the series.)

There are no orientation data in the project yet. 3D GeoModeller requires
orientation data before it can compute a series.

Perhaps you have some measured structural data for the f5 series. You could import
that data.

In the absence of measured data, we can provide an interpreted piece of orientation
data. We shall examine the drill-hole data made available to us in the section views
and decide where we can reasonably estimate the attitude of the (bottom of the) f5
boundary. After locating this we enter an orientation data point describing that
attitude.

In this tutorial we place the interpreted orientation data point on Section s81N.
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G1 Stage 5—Steps
1 Select the s81N section in the 2D Viewer.
In the Points List toolbar:

*  Choose Delete all Points [ to erase any contents of the Points List

+ Choose Create &% OR
press C.

2 Click the bottom of the f5 (pink) formation on the first drillhole. This is the
location of the orientation data point that you are creating.

Click the bottom of the f5 (pink) formation on the second drillhole. This indicates
the dip of the orientation point.

Click 1

Click 2
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3 In the Structural toolbar, choose Create geology orientation data > .

»4 Create geology orientation data E

Geological Formations and Faults

5 v
Section
S81N v
Provenance
Interpreted v
Data Type
() coordinates

(@) coordinates & direction
Coordinates

¥ | 549.355 Y | 405.635

Direction
Azimuth | 90. Dip |21.949

Polarity

() normal

(®)Reverse

[[] Automatically re-edit
[] Automatically update coordinates (%) Update now

[ ? Help I [ 3 undo ”  Create ” Ed close I

From Geological formations and faults, select f5.
From Provenance select Interpreted.
Choose Create.

4 Check the orientation data point. The shaft of the T shape should point up in the
section. If it points down, edit the point and reverse the Polarity.

To edit the point, point to it so that it turns white. From the shortcut (right click)
menu, choose Edit. In the Create geology orientation data dialog box, from the
Polarity options, select Normal or Reverse, whichever is not selected. Choose
Edit.

Close the Create geology orientation data dialog box.
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5 Compute the model with all series and sections.

From the main menu choose Model > Compute OR

From the Model toolbar choose % OR
Press CTRL+M.

Faults ortly

Series to nterpolate Faults to interpolate Sections to take into account Drilholes to take into account
| i series 5 s Map_Topo ‘ 1 VDH_s81N_01 |
& s8IV ‘“vﬂh,ssm,m El
N ‘ i VDH_sa 1N _07
& s85N ‘ iy VDH_s81N_09
§ =M ‘ W VDH_sa 1N_i0 [] Inequalities
& s8N ‘ i VDH_s81N_11
§ i ‘AVDH_SSLN_H
‘ i VDH_s83N_02

Select Al | Parameters | | Hint.. [ select Al |[ Desziectal | select All | Select All | [ Deselectal |

Global Parameters

Model limits Data

M 483100, | MMax 491700, |m “DlscPons |  Siplfication radus w.|m
M 4280700, | YMax 4291500, | m =& Use Ponts
2Min -2000. | ZMax 4000, |m “®UsePonts |

() Project zone |

‘ P Hep ‘ + oK ‘ Ed caze

For Series to interpolate, Sections to take into account, and, Drillholes to take
into account choose Select All.

Choose OK.

Contents Help | Top © 2013 BRGM & Desmond Fitzgerald & Associates Pty Ltd 4| Back | p



GeoModeller User Manual Tutorial case study G (Drillholes) 21
Contents | Help | Top 4 | Back | p

6 Plot the model with lines in each of the section views

From the main menu choose, choose Model > Plot the model settings OR

From the Model toolbar, choose Plot the model settings # OR
Pess CTRLA+D.

=" Plot the model settings

n
u direction | 50 v direction | 50 Node spacing: u=172, v=120m
[1show fil Shaw lines [] shew trend lines
Formations:
[ RS |
[ | | Faues:
Hint...
Select All | [ Deselect Al
P Help [ W ok H ~f Apply H G Apply to all H [Ed close l

From the Section drop-down list, select a section.

Check Show lines and clear Show fill.

Choose OK.

3D GeoModeller plots the model on the selected section.

From the main menu choose, choose Model > Plot the model on all sections OR
From the Model toolbar, choose Plot the model on all sections &' .

G1 Stage 5—Discussion

Note that 3D GeoModeller only calculates and plots the model for formation f5. To
calculate the model for a formation, 3D GeoModeller requires that there be at least
one orientation point associated with it. Currently, {5 is the only formation that
matches this criterion.

At these early stages of modelling a surface, you may get unexpected results.

This is mainly because there is very little orientation data to give information about
the attitude of the geology surfaces.

In the following stage, we shall work through the issues, dealing with the biggest
problems first.
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G1 Stage 6—Comparing the model with drillhole observations

Parent topic:
Tutorial G1—
Building a
model from
drillholes
(erosional
series f5)

Note: Using 3D GeoModeller’s ‘Compare the model with drillhole observations’
feature is a useful tool, but it is not required or obligatory in this case study. You may
be able to find and fix problems with the model just as easily using enlarged views
and examining the graphic representation.

When using drillholes, since the contact point from the data is certain, we would
expect 3D GeoModeller to place the geology boundary from the model exactly at this
point. Sometimes 3D GeoModeller places a geology boundary through the middle of
some drilled geology interval. Sometimes, also, the model surface appears to
‘meander’.

This is because 3D GeoModeller is using two other techniques that may, from its
viewpoint, conflict with the drillhole data:

+ It is trying to keep the model surface smooth.
+ It is using geological statistics to predict the course of the boundary.

These problems typically occur at the hole collar, and near the end-of-hole.

The problems are occurring at places where 3D GeoModeller does not have enough
information to generate the model properly. To fix the problems, add geology contact
or orientation points. As interpreters, we influence the modelling calculation
according to our belief about the geology.

We can do this by:
*  Tracing out a 'line-of-points' where we believe the geology should be OR
+ Add orientation data to influence the attitude of the geology horizons

Note that that we may not necessarily correct the data at the location of the error.
The error may result from lack of orientation data at a neighbouring drillhole. We
could even add mapping data on the surface that would resolve the problem.

Comparing the model with drillhole observations gives information about the location
of the problems. It does the following:

1 Examines each interval of observed geology from the drillhole data
2 Checks the model’s predicted geology over the same interval
3 Highlights drillholes where the difference error exceeds the specified precision.

Specify a large value for Precision first. This enables you to identify the big
problems. Fix those first. Often, fixing the big problems automatically fixes some of
the smaller problems.
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G1 Stage 6—Steps

1 From the main menu choose Model > Compare model with drillhole observations
OR

From the Model toolbar choose Compare model with drillhole observations #t.
2 For Precision, enter 200.

wD

5° Compare model with drillhole observations
Precision | 200 l ﬁCompare l l mclose ‘
Choose OK.
§ ==/ O E3

Highlighted drillholes
have model differences
compared to the drilled
intervals
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3 Fixthe problems at the drillholes where 3D GeoModeller has identified a problem.

You can experiment with adding geology contact or orientation points yourself, or
follow our solution.

In section s81N, add an orientation point between the third and fourth drillholes
from the left, to guide the model away from the loop that it is mistakenly
generating through the fourth, fifth and sixth drillholes.

Use the steps in G1 Stage 5—Prepare the project for modelling to add the new
point, recalculate and replot the model.

Compare the model with drillhole observations again with a distance of 200 m.
Add further points in other sections as required. Recalculate. The illustration
below shows the steps and the result.

1. Model has loop 2. Click trace points 3. Create orientation
point

4. Recalculate model 5. Add orientation points in other
sections as necessary and
recalculate.

In this illustration, we have removed discrepancies in the model to an accuracy of
200 m.
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4 Compare the model with drillhole observations using progressively finer
precision, 50 m, then 15 m, then 5 m, repeating steps 1-3.

At 50 m, we added orientation points to s81N and s91N. When we recalculated
the model, we found another problem in s85N, which we fixed. The results are in
the 1llustration below.
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As you work through the problems in the model, the interpreted horizon begins to
look more plausible.

- jects\DrillDnlapErode_O4a_Tute_DONE_f5

Important note about 3D GeoModeller’s ‘Compare the model with
drillhole observations’ feature: At larger Precision values, 3D GeoModeller
calculates genuine errors. You can review the project geology and add further
geology observations or interpretations to seek to resolve the reported
discrepancies.

At smaller Precision values, the 'errors' may be due to the mathematical
uncertainty in the model. You would gain very little from further interpretive
work to try and resolve such relatively small errors (‘small' relative to the overall
dimensions of the model project).

Contents Help | Top

© 2013 BRGM & Desmond Fitzgerald & Associates Pty Ltd 4| Back | p



Tutorial case study G (Drillholes) 27
4| Back | p

GeoModeller User Manual
Contents | Help | Top

G1 Stage 7—Creating a 3D view

Parent topic:
Tutorial G1—
Building a
model from
drillholes
(erosional
series f5)

When you are satisfied that you have modelled the f5 surface in a credible geological
manner, and that the model is consistent with the drilled geology intervals, you can
quickly generate a 3D surface and view this in the 3D Viewer.

G1 stage8—Steps

1 View the 40 drillholes in the 3D Viewer. (If not already displayed) In the Project
Explorer, from the Drillholes shortcut menu, choose Show.
2 Choose main menu Model > Build 3D formations and faults OR

In the Model toolbar choose Build 3D formations and faults &
Check Surface and choose OK.

3D Shape parameters (type and mesh resolution)

Build Formations [_] Faults

Type  ()Volume ) Column () Surface

Resalution () Isotropic 200. m

(%) Anisotropic X | 500 ¥ | 500, Z | 200,

Nodes nX |17 ny |22 nZ |30
B |
Smoothing ¥

Mone Medium High

More...

| VyOK || Mprply || wc\ose |

? Help

To change the colour of the surface, in the Project Explorer, from the shortcut
menu of Model > Surface f1_f5, choose Appearance.

Note that a completed version of Stage 8 of the tutorial is available in
\GeoModel ler\tutorial\CaseStudyG\TutorialG1\Completed project\
TutorialGl_2 f5\TutorialGl 2 f5.xml. Do not overwrite it.

Here is an illustration of the completed Tutorial G2 project

= 0 B3| N =] 5 E3| IS
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Tutorial G2—Building a model from drillholes (erosional series f2)

Parent topic: In this tutorial we create, display and refine the model for (erosional) series 2
’Sl‘ttté);i(a}l case After series f5 (Tutorial G1—Building a model from drillholes (erosional series {5)),
(Drillholes) series f2 is the next older erosional surface, and the next series for modelling (see

Strategy for Case Study G).

Repeat the steps from Tutorial G1—Building a model from drillholes (erosional series
5), but for section f2.

1 Start with your completed project from G1 Stage 6—Comparing the model with
drillhole observations or open the completed version that we have supplied
\GeoModel ler\tutorial\CaseStudyG\TutorialG1l\Completed_project\
TutorialGl_2_ f5\TutorialGl_2_ f5.xml.

2 Start repeating the steps from G1 Stage 4—Project the Drillholes in each 2D
Section-View.

3 Continue to the end of G1 Stage 7—Creating a 3D view.

Note that a completed version of this tutorial is available in
\GeoModel ler\tutorial\CaseStudyG\TutorialG2\Completed_project\
TutorialG2_f5f2\TutorialG2_f5F2.xml. Do not overwrite it.

Here is an illustration of the completed Tutorial G2 project

~ sBIN =l O B BRI - 08B - 0B EEN-Tc
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Tutorial G3—Building a model from drillholes (onlapping series 3)

Parent topic: In this tutorial we create, display and refine the model for (onlapping) series f3
’srtl:lté);iél e Now that we have modelled the erosional series, we are ready to model serties f3, the
(Drillholes) oldest onlapping series (see Strategy for Case Study G).

Repeat the steps from Tutorial G1—Building a model from drillholes (erosional series
5), but for section f3.

1 Start with your completed project from Tutorial G2—Building a model from
drillholes (erosional series f2) or open the completed version that we have
supplied
\GeoModel ler\tutorial\CaseStudyG\TutorialG2\Completed_project\
TutorialG2_f5f2\TutorialG2_f5f2._xml.

2 Start repeating the steps from G1 Stage 4—Project the Drillholes in each 2D
Section-View.

Note that a completed version of this tutorial is available in
\GeoModel ler\tutorial\CaseStudyG\TutorialG3\Completed project\
TutorialG3_f5f2Ff3\TutorialG3_f5Ff2F3.xml. Do not overwrite it.

Here is an illustration of the completed Tutorial G3 project
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Tutorial G4—Building a model from drillholes (onlapping series f4)

Parent topic: In this tutorial we create, display and refine the model for (onlapping) series f4
Tutorial

stllllé);l(a; case After series 3, series f4 is the next youngest onlapping surface, and the recommended
(Drillholes) next series for modelling (see Strategy for Case Study G).

Repeat the steps from Tutorial G1—Building a model from drillholes (erosional series
5), but for section f4.

1 Start with your completed project from Tutorial G3—Building a model from
drillholes (onlapping series f3) or open the completed version that we have
supplied
\GeoModel ler\tutorial\CaseStudyG\TutorialG3\Completed_project\
TutorialG3_f5Ff2Ff3\TutorialG3_f5f2Ff3 . xml.

2 Start repeating the steps from G1 Stage 4—Project the Drillholes in each 2D
Section-View.

3 Continue to the end of G1 Stage 7—Creating a 3D view.

Note that a completed version of this tutorial is available in
\GeoModel ler\tutorial\CaseStudyG\TutorialG4\Completed project\
TutorialG4 _f5f2Ff3Ff4\TutorialG4_f5F2F3f4.xml. Do not overwrite it.

Here is an illustration of the completed Tutorial G4 project

o B [ SR
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Tutorial G5—Building a model from drillholes (onlapping series 6)

Parent topic: In this tutorial we create, display and refine the model for the final (onlapping) series
Tutorial case f6

study G

(Drillholes) After series f4, series f6 is the next youngest onlapping surface, and the next series

for modelling (see Strategy for Case Study G).

Repeat the steps from Tutorial G1—Building a model from drillholes (erosional series
£5), but for section 4.

1 Start with your completed project from Tutorial G4—Building a model from
drillholes (onlapping series f4) or open the completed version that we have
supplied
\GeoModel ler\tutorial\CaseStudyG\TutorialG4\Completed_project\
TutorialG4_f5F2F3f4A\TutorialG4_f5F2F3F4 . xml.

2 Start repeating the steps from G1 Stage 4—Project the Drillholes in each 2D
Section-View.

3 Continue to the end of G1 Stage 7—Creating a 3D view.

Note that a completed version of this tutorial is available in
\GeoModel ler\tutorial\CaseStudyG\TutorialG5\Completed_project\
TutorialG5_f5F2Ff3f6\TutorialG5_f5F2F3F6.xml. Do not overwrite it.

Here is an illustration of the completed Tutorial G4 project
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The following illustrations are of the final model, using line and filled mode.

HEyLf Ao N / w<iew a0 HEE &20
= = = oB N
n

\Projecti\DrillOnlapErode_O4a_Tute_DONE_(S(213{416_NEARLY
ewch

FyEAA MBS AN W< @0 BED 8258 %0

Tutorial G6: Import Drillhole Assay Data

1 Choose Import > Drillhole > Assay Data into Existing Drillholes

3f4f6  el\proc\geomodeller\mgrids\tutegS_vtkdrivers
tion (Import| Export View Window Research Help

f @@ GIS and Other Binary Located Data G E‘ | % | {’{j @ | & r|

2D Data
o 2D Sections
3D Data
Drillhole ' #8% 3 Files (Collars, Surveys, Geology)
Grid and Mesh &5 BRGM ASCI format
Seismic )

@ BRGM GDM format
¥%%  Assay Data into Existing Drillholes

Rl - GeoSciML Borehole

2 The Import ASCII Wizard will pop up.

1 On the first page, select the input file:
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\GeoModel ler\tutorial\CaseStudyG\TutorialG5\Data\AssayImport
Example.csv

2 On the second page you will see the file is formatted correctly already. Choose
Next to go to page 3.

3 Set the column mapping for the Hold ID.

[ CSV Data Import - - i (25—
Steps Select Col to Import (Step 3 of 3)
1. Select data type to import HoleID From To Au
;'- P5m| CSVI C EEI toT " 1 VDH s85MN 08 (1700 1780 ] =
2 VDH s85M 08 (1730 1790 0.5
3 VDH s85M 08 (1790 2000 0.75
4 VDH s85N 08 (2000 2010 1.78
5 VDH s85M 08 (2010 2020 2.32 =
] VDH s85N 08 (2020 2030 3.07
7 VDH s85M 08 (2030 2040 6.3
8 VDH s85N 08 (2040 2080 6.3 | &
9 VDH s85M 08 (2080 2100 10.1
10 VDH s85M 08 (2100 2150 5.4
11 VDH s85M 08 (2200 2250 7
12 VDH s85M 08 (2250 2500 ]
13 VDH s85M 11 (500 572 ] -

Column Size: [] Auto [ [E]I ” == ” Reset

Columns

Treat as: lHcale ] - ,
Mot Import

Field PropHole ID

From

Mame: |Hro Description:

Type: (Real Unit:

Mull value:

@ Interval ‘From' not defined

3 Set the column mapping for the From and To in the same manner

4  Set the Au field paraters. Set the Type to Real, set the name, description and
units as desired. The default NULL value can be used.
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BB CSV DataImport -

===

Steps Select C to Import (Step 3 of 3)
1. Select data type to import HoleID From To Au
;'- PSE'SE| CSVI C EEI toT " 1 VDH s85MN 08 (1700 1780 ] =
2 VDH s85M 08 (1730 1790 0.5
3 VDH s85M 08 (1790 2000 0.75
4 VDH s85N 08 (2000 2010 1.78
5 VDH s85M 08 (2010 2020 2.32 =
] VDH s85N 08 (2020 2030 3.07
7 VDH s85M 08 (2030 2040 6.3
8 VDH s85N 08 (2040 2080 6.3 | &
9 VDH s85M 08 (2080 2100 10.1
10 VDH s85M 08 (2100 2150 5.4
11 VDH s85M 08 (2200 2250 7
12 VDH s85M 08 (2250 2500 ]
13 VDH s85M 11 (500 572 ] -

Column Size: [] Auto [ [E]I ” == ” Reset

Columns

| HoleID
T From
L To

Treat as: :Field

Field Properties

MName: Au|
Type: :Real

Mull value:

Description: |Gold

« | Unit: |uvv

Next >

5 Choose Finish to close the wizard and import the data.

Tutorial G6 - Drillhole Properties Dialog

To view the assay field data for a drillhole you can use the Drillhole Properties

Dialog.

1 Expand the Drillhole list in the Project Explorer tree

 Explore

[+ [l Formations

a Dykes

. Faults

G- ﬁ Sections

----- /- VDH_s81N_01
----- J= VDH_s81N_04
----- /= VDH_s81N_07
----- -l VDH_s81N_09
----- -l VDH_s81N_10
----- -l VDH_s81N_11
----- J- VDH_s81N_14
----- /= VDH_s83N_02
----- 1= VDH_s83N_04
----- /-l VDH_s83N_07
----- -l VDH_s83N_09

[ .} DrillOnlapErode_04a_Tute_DOME_f5f2f3f4fc

2 Find Drillhole VDH_s87N_07 in the list and open its context menu using the
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mouse.

e
{ 25 VDH_s87N_07

N
s
T
&
g
q‘r

----- 'JIL, VDH_s89M_0 8
e
----- e, VDH_s85N_0 &

i, VDH_s87N_07

Show

Appearance
Edit...
Delete

Properties

3 Choose Edit to open the Drillhole Properties Dialog

& Drillhole
Drillholes Edit Format Help

|
|
|
|
|
|
|
|
|
I
I
I
I
I
I
I
I
I
I

Explore/Edit Drillhole Log

&

=

W VDH_sB7N_07
B r*‘ Geological Information

#: Collar location

. Log Intervals
o[

- From: 0

- Tor 677

- Mot relaxed
- From: 677
- Tor 1167
- Mot relaxed
- From: 1167
- To: 1504
- Mot relaxed
- From: 1504
- Tor 2542
- Mot relaxed
- e

- From: 2542
- To: 4298

- Mot relaxed

f1

- From: 4298
L To: 4500
“ User Defined Data

- ,m} Fields (assays, ...)

fea

1| Current_Model

rDrillhole logs

~

DrillholeVDH_s87N_07 at: (X=487100, Y=4287000)

ical Model Misfit = 0.08%

logical Log / G

[
25 50 75 100

Depth

250

500

750

1,000

1,250

1,500

1,750

2,000

2,250

2,500

2,750

3,000

3,250

3,500

3,750

4,000

4250

4,500
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This dialog shows the drillhole log in the tree on the left hand side. The columns
next to this highlight the drillhole log/geological model misfit and the assay field

plot. As can be seen here there is now assay data in this drillhole.
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Tutorial G6: Assay Data to Observation MeshGrid

Once assay data has been imported into drillholes you will generally want to
perform some sort of interpolation, analsysis or processing. To do this in
GeoModeller v2012 you must first create an Observation MeshGrid from Drillhole
fields.

1 Right click on the Drillholes entry in the project tree to bring up the context
menu

* Explore [=)| & BN | & s89N o

=~ .\ DrillOnlapErode_04a_Tul

a Formations

l-ij Dykes

H Faults

ﬁ Sections

_I:‘\é‘II Dok m Drillholes
..... 25 ol

..... 5 Vol @ Show

..... 7. VOl @» Appearance

.
""" . VDI Import...

..... .
. VB! h Fields to Regular Intervals
Fields to Data Points Mesh

Delete
|

\g \E \g
gl E
u ‘,g;

Grid Name: | DrillholesFields

Drillholes Fields

i VDH_s81N_01 - Au

i VDH_s81N_04

i VDH_s81N_07

(i VDH_s81N_09

m

(i VDH_s81N_10

(i VDH_s81IN_11

i VDH_s81IN_14

i VDH_s83N_02

i VDH_s83N_04

(i VDH_s83N_07

(i VDH_s83N_09

(i VDH_s83N_12

(i VDH_s83N_13

(i VDH_s85N_01

i VDH_s85N_04

(i VDH_s85N_05

(i VDH_s85N_06 -

I Select Al H De-select Al I | Select Al |I De-select Al I

I Reset I I oK I I Cancel I

3 Choose Select All for both the drillholes (left side) and Fields (right side). Then
choose OK to close the dialog and create the MeshGrid.
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You should now see the MeshGrid in the Project tree.

* Explore =

=~ . DrillOnlapErode_04a_Tute_[
+ (4 Formations

- l-ij Dykes

+ & sections

+ & 30 Geology

en  Grids and Meshes
5 %} DrillholesFiglds

L. .
v, Au

This tutorial will not cover the vast number of tools available when working with
MeshGrids. Instead a very simple “quick preview” interpolation of the assay data
using Inverse Distance Interpolation will be shown.

NOTE: GeoModeller v2012 now supports both traditional Kriging and domain
Kriging. Kriging can provide much better results than the Inverse Distance
Iinterpolation.

Tutorial G7: Inverse Distance Interpolation

In this exercise you will:

*  Compute a new MeshGrid field using the MeshGrid calculator.

+ Interpolate data in a MeshGrid field using Inverse Distance Interpolation.
* Add your Geological model as a field to an existing MeshGrid.

+  Use the calculator to threshold field data by unit.

It is common for Gold data to have a log-normal distribution. For interpolation it is
desirable to normalise the distribution first. Therefore, the first step in this exercise
1s to use the MeshGrid calculator to take the LOG of the Gold field Au.
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Compute the LOG of a MeshGrid field
1 Right click on the MeshGrid DrillholeFields and choose Compute New Field

from the context menu.
i [ Drilholes
n @ 30 Geology
=l W Grids and Meshes
B 3:; Drll'u:les':"‘""

[)fifhcleﬁel&

Hide All Views of this Mesh/Grid

&  Add Current Model Field
i%,_ Crezte Coordinates(X,Y,Z) Fields

=fl Export.
Bla, | Add Fields from 2D Grid

° Compute New Field...

E Multi Crossplot with

r;r Merge this Gnd with Another b
Create a Compatible Grid with L
Group Fields
Flow Rate / Pressure Plot

8 Delete

Properties

2 In the calculator dialog:
1 Choose In (natural log) from the Function Keys
Choose Au from the Field List
Choose “)” from the Function Keys to close the brackets.

Change the Result Field Name to “log_au” or something appropraite.

Ot B~ W N

Choose Evaluate to evaluate the expression and create the new field.

Result field name

E)c_pression to evaltse. Eg if (Density==nan;2.7;Density) nb seperator is ; )

fln( Au) - . ield Name: |log_au

E.ist sign.al N Euncﬁons : m

A Lo J o J @ J w J o J abs JH A

log_au [ int ][ frac ][ asin ][ acos ][ atan ][ atan2 ] { : H . H s H - }
[ sinh ][ cosh ][ tanh ][ asinh ][ acosh ][ atanh ]
[ ceil ][ floor ][ round ][ exp ][ sqr ][ sqrt ] l 4 " 5 " [ " / l
Lo J o J e e Jo ¢ O QS IS . |
Lf JLa J ® J > JJ < J < ]l ol

L Del k

A Evaluate Refresh All Save and Exit ﬁ
FiE"dLLIiSt Function Keys

Numeric Keys

Action Buttons

6 Choose Save and Exit to save the results into the Projet tree.

Important: You must always Evaluate the expression before choosing Save and
Exit. Otherwise the result will not be saved in the Project Tree.

You should now have two fields in the MeshGrid, as shown.
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~ Explore =

=~ . DrillOnlapErode_04a_Tute_[
a Formations
ﬁj Dykes
H Faults
¢ ﬁ Sections
“m Drillholes
ﬂ 3D Geology
 Grids and Meshes

v DrillholesFields

Inverse Distance Interpolation

1 Right click on the log_au field to open the MeshGrid field context menu. Choose
Inverse Distance Interpolation.

+- @ 30 Geology
=} ¥ Grids and Meshes
5 B DrilholesFields
= Au
[ Mg _godl

iog god

. Hide Field from All Views

(7
ﬁ' Field Visualisation Manager

}') Appearance
dis  Edit Colours and Clips
P Display Color Table

Histogram
Gutenberg-Richter Plot

EE

T Nearest Neighbour Analysis

Varicgram Analysis

e Domaining Estimatior

E Inverse Distance Interpolation J

Cross Validati

ol f Kriging E
1
]

BN Domaining Validation

Gaussian Anamerphosis Transformation

B Gaussian Simulation on a Domain
B  Goussian Simulation All Mode =
&) Polynomial Approximation *

}#  Cross Plat with Ancther Field
S5 Multi Crossplot with
Multi-field Analysis

2 Delete

& Properties

2 In the dialog choose New Grid and enter the name of the grid. Here it is shown as
inv_log_gold.
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Define Target Grid

1.
2. Grid Definition
B

Definition

Define Target Grid

Interpolated Field and
Standard Deviation Field

(@) New Grid Grid Mame: inv_log_hold

Add to an Existing Grid ~ Grid:

Choose Next to move to the next page of the wizard.

4 | Back | p

3 On the next page under Grid Definition choose Fixed and enter 250m cell
spacing. Then specify the Maximum Radius of Neighbourhood as 3000
metres.

EE [nverse Distance Interpolation

Steps Grid Definition

1. Define Target Grid . . -

2. Grid Definiti Grid Definition for Kriging

3. Interpolated Field and S - .
Standard Deviation Field CIFE () EEEE
Definition

Size 250 |m
X 955.556 | m Y 981818\ m Z 600, | m
nx 34 ny 43 nZ 24
Build 3D Limits
¥Min | 483100.00 ¥Max | 491700.00 m =& Use Points
YMin | 4280700.00 YMax |4291500.00 m =& Use Points
ZMin |-2000.00 IMax |4000.00 m =% Use Points
@ Project Zone
Meighborhood Definition
Maximum Points in Neighborhood: G
5 15 25 35 45 55 65 75 85 95
Minimum Points in Neighborhood: G
2 12
Maximum Radius of Neighborhood: 3000,

Choose Next to go to page 3 of the wizard.

4 Enter the name of the interpolation field. In this example it is called
interp_log_au.
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r
EE Inverse Distance Interpolation s

|| Steps Inter I i Field and Standard Deviation Field Definition

1. Define Target Grid

2. Grid Definition

3. Interpolated Field and

| Standard Deviation Field
Definition

Field Name: inteerog_au

< Back Mext = Einish Cancel

Choose Finish to perform the interpolation.

You should now have a new MeshGrid in your project called inv_log_gold, or
whatever name you chose of page 1 of the wizard. This grid is a regular voxet with
fixed cell size of 250m.

~ Explore =

=~ . DrillOnlapErode_04a_Tute_[
+ (4 Formations

i l-ij Dykes

> H Faults

+ ﬁ Sections

+ “m Drillholes

+ ﬂ 3D Geology

% Grids and Meshes

1 DrillholesFields

= 3"1 inv_log_gold

L7

interp_log_au

Remove linearisation of the interpolated field.

Recall that the interpolation was performed on the log of the gold assay data. Now
you will need to remove the linearisation to revert back to a log-normal distribution.

1 Right click on the inv_log_gold and choose Compute New Field. This will open
the calculator dialog box again.

1

2
3
4

In the calculator perform the following steps:

Choose exp from the Function Keys,
Choose interp_log_au from the Field List
Choose “)” to close the brackets.

Enter the name for the new field. Here it is specified as interp_Au.
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5 Choose Evaluate followed by Save and Exit.

if(Densityb seperator is ;

exp(interp_log_au) Field Name: | interp_Au

List signal Functions Keyboard

Lo = Lo Jn e ][ -

terp_Au [ int ][ frac ][ asin ][ acos ][ atan ][ atan2 ] { : H . H s H - }
[ sinh ][ cosh ][ tanh ][ asinh ][ acosh ][ atanh ]
[ ceil ][ floor ][ round ][ exp ][ sqr ][ sqrt ] l 4 " 5 " [ " / l
Lo Joom J e Jowe Jo ¢ O JF 0, 0 . |
L Jooa Joo® Joo> Jo< J o |
L= = Jower m Jee L owJlefofo -]

| Evaluate [ Refresh All ] [ Save and Exit ]

You should now have the new field interp_Au in your project MeshGrid
inv_log_gold

 Explore =

= . DrillOnlapErode_04a_Tute_[
-- a Formations

-- ﬁ Sections

-- m Drillholes

-- - 3D Geology

E} W Grids and Meshes
.. BY DrilholesFields

3 Explore the field interp_Au by looking at the histogram and statistics. Right
click on the field and choose Histogram from the context menu. This will bring
up the histogram dialog which also contains summary statistics.
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& Histogram of i

Histogram of interp_Au Statistics

Property Value
' 250 n-Total 35088
16 n-Effective 15227
n-Nulls 19861
15 225 %e-Mulls 57%
1.4 Min 0.62672
13 200 Max 9.351338
: Mean 4.209932
1.2 = Geo Mean 4.093318
11 75 g Std Deviation |1.049665
= . _ . _ g Kurtosis 4.807398
=_i,l 10 an = 4.208032 Sigma = 1.040865 150 E Skewness 1.603323
=3 -
Soe oS Variance 1.101797
E @
Z o8 125 g
E o
07 =
100 5
o0& w
05 75
04
03 50
0z
25
0.1
0o a
05 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 80 85 ALL -

interp_Au

4 Now display the voxet in the 3D viewer. Right click on the interp_Au field and
choose Field Visualisation Manager to show the visualisation dialog. For now
just select View Grid in 3D as a 3D Volume.

& 30 View =l B =8

Because we know that the gold is all in the f3 unit we have shown it here as a
wireframe. You will notice immediately that the interpolation is not contrained to
this unit. It is for this purpose that you would choose Domain Kriging.

However, we can still visualise and perform processing on the inverse distance
interpolated data which only falls within the unit 3. To do this two steps
additional steps are required.
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1 Add a model field to the MeshGrid

2 Threshold the interp_Au field to only those voxels within the £3 unit using
the model field.

Adding a model field to a MeshGrid

Any MeshGrid can have a model field added to it. A model field is a lithology field
that contains the units at each cell in a MeshGrid. For example, a voxet model field
will the lithology unit number that each voxel is in, whereas, an observation
MeshGrid will contain the unit number at each point of the mesh grid.

1 Right click on the inv_log_gold MeshGrid and from the context menu select Add
Current Model Field.

- (@ 30 Geology
5} % Grids and Meshes
= B DrilholesFields
LI
7 log_gold
= 24 inv_log_geld, 5

Einazru_h winv_log_gold

~ WWinterp A s ide All Views of this Mesh/Grid

@  Add Current Model Field

b113 Create Coerdinates(XY,Z) Fields
i Egport.
Add Fields from 2D Grid
0 Compute Mew Field...
Multi Crossplot with

Merge this Grid wit

Create a Compatible Grid wi

Group Fields.
Flow Rate / Pressure Plot

#  Delete

& Properties

You should then see in your Project Tree the new field Current_Model_Grid.

~ Explore =

=~ . DrillOnlapErode_04a_Tute_DOME_f5f2f3f4f6
a Formations

+ ﬁ Sections

+ “m Drillholes

- ﬂ 3D Geology
"

3";1 inv_log_gold
interp_log_au

L7

n interp_Au

i1 5
A2+ Current_Model_Grid

2 Right click on the inv_log_gold MeshGrid to open the context menu and choose

Compute New Field.

3 In the Calculator Dialog, perform the following steps:

1 Choose IF from the Function Keys
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Choose “;” from the Numeric Keys
Choose interp_Au from the Field List
Choose “;” from the Numeric Keys
Choose NaN from the Numeric Keys

Chosoe “)” from the Function Keys.
Yy

Enter the result field name as interp_Au_f3

10 Choose Evaluate followed by Save and Exit.

EE Calculator

Expression to evaluate. Eg if (Density==nan;2.7;Density) nb seperator is ;

if{ Current_Model_Grid == 3;interp_Au;nan)

List signal Functions

Choose Current_Model _Grid from the Field List

Choose “==" from the Function Keys, followed by “3” from the Numeric Keys.

.

«|Back | p

Field Name: |interp_au_f3

Keyboard

interp_log_au sin

cos

interp_Au
Current_Model_Grid

asin

atan2

interp_Au_f3

cosh

tanh

atanh

floor

round

sgrt

+-

R

7

[

4

min

max

AND

CR

<

NOT

Del

1

N

0

>

|
|
NN
|
|

| Evaluate || Refresh All || Save and Exit |

The expression should look like the one above. It simply says:

IF voxel lithology is f3 THEN output interp_Au ELSE output null.

4 Visualise the new field using the Field Visualisation Manager, via the context
menu of the interp_Au_f3 field. In the dialog choose View Grid in 3D and 3D

Volume.

& 2D View

The visualisation now shows interpolated gold data within the lithology unit of
interest. You can view the colour map via the context menu for the field
interp_Au_f3. Choose Edit Colours and Clips.
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B Adjust Color Curve: in

. |
1.0 15 20 25 30 35 40 45 50 55 60 65 7.0 75 80

Data Clip :Daia Limits v: 0.6286448435 To |8.274245805
Visibility Clip :Daia Limits v: 0.6286448435 To |8.274245805
Colour . 1 Pseudocolor 1 =

Transformation |Linear -

[ Close ] [ Apply i

Estimate the volume of gold within the f3 unit.

1

To get an estimate of the volume with the f3 unit you can use the MeshGrid
Calculator again. Open the calculator from the context menu of inv_log_gold.

Create the expression: IF(interp_Au_f3 <> NaN;Current_Model_Grid;NaN)
using the keys and field list.

Enter the name of the new field as interp_Au_f3_lithology.
Choose Evaluate followed by Save and Exit.
Check that the field was created in the project tree.

Right click on the new field interp_Au_f3_lithology and choose Properties.
This will open the properties dialog.

In the dialog change the Alias from none to Lithology.

Field rties -
o . W K
Manage MeshGrid Field Properties W W
HX HHH
X
oK H X
Mame: interp_aAu_f3_lithology Type: Real
Units: Alias: |Lithology
DeSaRHEE if{ interp Au f3 <> nan;Current Model Grid;nan)
Elements: | 35088 Memory usage: | 274.12Kb
[ OK ] [ Cancel ]

Choose OK. GeoModeller will now recognise this field as a lithology field.

7 Open the context menu for the field interp_Au_f3_lithology and choose

Histogram. This will display the histogram together with the volume of voxels
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100
95
90
85
80
75
70
65
60
55

50

Percentage (2o)

20

Geological Model

3
Lithology

Volume

Lithology
3

Volume {m3)
|3.107812E10

S

Compare this number with the value from the Current_Model_Grid field.

100
95
90
85
80
75
70
65
60
55

50

Percentage (2o)

20

7T

22.251

12.807
10.11 10724

I I 6.336 | I
fa

4 5 fa
Lithology

The volume of unit 3 is 4.604688E10 m™

B Histogrom o CM@
Geological Model Volume

Lithology Volume {m3)
i 4,884375E10
5 5.832812E10
4 2,885938E10
3 4,604688E10
f2 1.013438E11
f1 1.720312E11

b

The volume of unit £3 which contains (interpolated) gold is 3.107812E10 m?

This does not show an estimate of the grade of the gold in the f3 unit, just the cells
which contain gold.

Contents Help | Top

© 2013 BRGM & Desmond Fitzgerald & Associates Pty Ltd

4| Back | p



	Tutorial case study G (Drillholes)
	Case study G-Introduction
	Project data preparation
	Topography of Case Study G
	Geology of Case Study G
	Strategy for Case Study G

	Tutorial G1-Building a model from drillholes (erosional series f5)
	G1 Stage 1-Open the prepared 3D GeoModeller Project for Case Study G
	G1 Stage 2-Import the drillhole data
	G1 Stage 3-Arrange the 2D Viewer windows
	G1 Stage 4-Project the Drillholes in each 2D Section-View
	G1 Stage 5-Prepare the project for modelling
	G1 Stage 6-Comparing the model with drillhole observations
	G1 Stage 7-Creating a 3D view

	Tutorial G2-Building a model from drillholes (erosional series f2)
	Tutorial G3-Building a model from drillholes (onlapping series f3)
	Tutorial G4-Building a model from drillholes (onlapping series f4)
	Tutorial G5-Building a model from drillholes (onlapping series f6)

	Tutorial G6: Import Drillhole Assay Data
	Tutorial G6 - Drillhole Properties Dialog
	Tutorial G6: Assay Data to Observation MeshGrid
	Tutorial G7: Inverse Distance Interpolation


